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Sharing
Terminology and User Interface Cross-Reference
ArcGIS Pro ArcMap and Other ArcGIS Desktop Applications

Share content
Umbrella term referring to packaging, publishing, and sharing 
new ArcGIS Pro items

Project package (.ppkx) File type used to package an entire project (new in ArcGIS Pro)

Map package (.mpkx) File type used to package a map; similar to an .mpk file

Layer package (.lpkx) File type used to package an individual layer; similar to an .lpk file

Share or publish a web layer Publish a service

Share Web Layer pane Publishing wizard and Service Editor

Messages tab Similar to the Prepare window

Web layer Service

Web feature layer Feature service

Web tile layer Tile service/Cached map service

Project template (.aptx)
File type used to build a template for a new project (new in  
ArcGIS Pro)

Save As Map File Similar to File > Save As

Map file (.mapx) Similar to an .mxd file

Save As Layer File Similar to Save As Layer File 

Layer file (.lyrx) Similar to an .lyr file

Export Map Similar to File > Export Map

Tile package (.tpk)                           File type used to package web map or elevation tiles

Vector tile package (.vtpk) File type used to package vector tiles and styles

Scene layer package (.slpk)
File type used to package multipatch, point and point cloud 
features

Geoprocessing package 
(.gpkx)

File type used to share analysis services

Mobile map package (.mmpk)
File type used to share maps, basemaps, locators, and networks 
to mobile apps



ArcGIS® 
Pro Usage

Similar Concepts in Other
ArcGIS Desktop Applications

Project
A collection of related geographic datasets, maps, 
layouts, tools, settings, and resources, saved in an 
.aprx file

Map
The project item used to display and work with 
geographic data in two dimensions (A map opens 
in a map view.)

Data frame

Scene The project item used to display and work with 
geographic data in three dimensions

Global scene: ArcGlobe™ document (.3dd)
Local scene: ArcScene™ document (.sxd)

Ribbon
The rectangular area across the top of the 
application composed of tabs that contain 
software functionality

User interface menus and toolbars

Tab on the 
ribbon

A region on the ribbon that groups related 
software commands Toolbar

View The window representing the primary work area of 
the application

Similar to a map view or layout view, but there 
can be other types in ArcGIS Pro

Active view The view that currently has keyboard focus (The 
active view controls the contents of the ribbon.) Active data frame

Pane A dockable window that contains a related set of 
commands Dockable window

Gallery A rectangular window or menu that presents an 
array or grid of visual choices

Task A set of preconfigured steps to guide users 
through a workflow or business process

Similar to functionality in the Task Assistant 
Manager extension

Quick Access 
Toolbar

A collection of icons located on the title bar that 
provides shortcuts to commonly used commands

Portal Connection to an ArcGIS Online or Portal for 
ArcGIS organization

Similar to ArcGIS Administrator > Add Portal 
Connection. In ArcGIS Pro, connect to a 
portal on the Project tab > Portals tab

ScreenTips Pop-up info tips that appear when you hover over 
the ribbon Hover over a button on a toolbar

KeyTips Small tips that appear when you press the Alt key 
and show keyboard shortcuts for the ribbon Press Alt and an underlined letter

Range Optional dynamic filter that can be applied to a 
map based on numeric values

Has the similar concept in other Desktop 
apps of a Geoprocessing Service
Project pane is renamed to Catalog pane

Web Tool An analysis tool that runs through the web or on 
a server  

ArcPy.da Python module for data access

ArcPy.na Python module for network analysis

ArcPy.sa Python module for spatial analysis

ArcPy.wmx  Python module for workflow management

Essential Terminology or Functionality That’s New to ArcGIS® Pro



General Items
Terminology and User Interface Cross-Reference
ArcGIS Pro ArcMap and Other ArcGIS Desktop Products

Contents pane Table of Contents window

Catalog pane and  
Catalog view

Similar to the Catalog window

Map view Data view

Layout view Layout view; layout of an ArcMap document (.mxd)

Select item in Contents 
pane to open additional 
ribbon tabs and tools

Right-click item in Contents window to access the context menu 
(This is still available in ArcGIS Pro.)

Explore tool
Contains functionality of Pan, Zoom, and other navigation tools, and 
HTML Pop-Up and Identify tools

Click with the Explore tool
Get a pop-up window about what you clicked; similar to HTML 
Pop-Up and Identify tools

Attributes pane
Similar to the Attributes and Identify Results windows, also 
allows editing

Default project database Default map (or scene or globe) document geodatabase

Locate pane Find tool

Add Folder Create Folder Connection 

Edit tab on the ribbon Editor toolbar

Geoprocessing pane 
(opened from the Analysis 
tab)

Search tools, show the system toolbox, and run geoprocessing 
tools; similar to ArcToolbox™ window and tool dialog boxes

Geoprocessing History Results window

Fields, Subtypes, and 
Domains views

Feature Class Properties and Geodatabase Properties 
dialog boxes

Project tab > Options Contains settings for customizing ArcGIS Pro

Data tab > Export Features 
(opens Copy Features tool)

Right-click a layer in the table of contents > Data > Export Data

Active Portal
Default connection to the ArcGIS Online or Portal for ArcGIS 
organization where you share and search for content

Essential Terminology or Functionality That’s New to ArcGIS® Pro



Mapping and Visualization
Terminology and User Interface Cross-Reference
ArcGIS Pro ArcMap and Other ArcGIS Desktop Applications

Symbology pane Symbology tab on the Layer Properties dialog box

Symbology pane > Gallery Symbol Selector

Symbology pane > Properties Symbol Property Editor

Point symbol Marker symbol

Polygon symbol Fill symbol

Color scheme Color ramp

Style File Style File

Favorites style Personal style

Project styles Referenced styles

Preset layer
A prebuilt layer embedded in ArcGIS Pro that only requires a 
data source

Raster functions
Similar to Image Analysis window > Processing section, but 
exposes all functions and more functionality

Appearance tab for rasters Similar to Image Analysis window > Display section

Activate map frame on a layout Similar to focus data frame on a layout

Element pane Element property dialog boxes

Save As Layout File Similar to File > Save As

Layout file (.pagx) Similar to templates

ArcPy.mp
Significant update to the ArcPy.mapping module for Python 
scripting



Copyright © 2017 Esri. All rights reserved. Esri, the Esri globe logo, ArcGIS, ArcMap, ArcGlobe, ArcScene, ArcToolbox, arcgis.com, and esri.com are trademarks, 
service marks, or registered marks of Esri in the United States, the European Community, or certain other jurisdictions. Other companies and products or 
services mentioned herein may be trademarks, service marks, or registered marks of their respective mark owners.

  G78102

Additional ArcGIS Resources

ArcGIS Online: arcgis.com

What’s New in ArcGIS: esri.com/whatsnew

Support: esri.com/support

Training: esri.com/training

Books: esri.com/esripress

Editing

ArcGIS Pro Similar Concepts in Other ArcGIS Desktop Applications
Editing is enabled at all 
times

Start editing

Active Select tool on the 
Modify Features pane

Edit tool

Create Features pane Create Features window

Modify Features pane
Contains tools for editing features, similar to those on editing 
toolbars

Manage Templates pane Organize Feature Templates window

Reposition toolbar
Contains Move, Scale, and Rotate tools, similar to those on 
editing toolbars

Construction toolbar
Contains segment construction tools, similar to those on 
editing toolbars

Vertices toolbar Edit Vertices toolbar
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  Resources for Learning ArcGIS Pro     

 

Introduction: 

The ArcGIS Pro app: 

http://pro.arcgis.com/en/pro-app/ 

Get started with ArcGIS Pro: 

http://pro.arcgis.com/en/pro-app/get-started/faq.htm  

Overview:  http://pro.arcgis.com/en/pro-app/get-started/overview-of-arcgis-pro.htm 

Esri Documentation starting point:  https://doc.arcgis.com/en/   

Videos on ArcGIS Pro: 

Esri Channel – search on ArcGIS Pro:  https://www.youtube.com/user/esritv/search?query=arcgis+pro 

Joseph Kerski’s channel – search on ArcGIS Pro:   

https://www.youtube.com/user/geographyuberalles/search?query=arcgis+pro  

Migrating from ArcMap to ArcGIS Pro: 

Migrating to Pro: 

http://pro.arcgis.com/en/pro-app/get-started/migrate-to-arcgis-pro.htm 

One user’s guide: 

https://www.esri.com/arcgis-blog/products/arcgis-pro/administration/my-road-to-pro-a-guide-to-

getting-up-and-running-with-arcgis-pro-in-a-redlands-minute/ 

Lessons: 

10 Lessons using public domain geospatial data and solving problems: 

http://spatialreserves.wordpress.com 

The Learn Lesson Library:  http://learn.arcgis.com 

Lessons are also included in Esri training and in books (see below). 

Esri Training: 

Esri Training:  Webinars, activities, courses, and more:  http://www.esri.com/training 

Esri Higher Education Training Document: 

https://community.esri.com/docs/DOC-11266-esri-elearninghigher-ed-planning-guidespring2018pdf 

ArcGIS Pro Quick Start Tutorials: 

http://pro.arcgis.com/en/pro-app/get-started/pro-quickstart-tutorials.htm 
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Esri MOOCs:  http://www.esri.com/mooc – Cartography, Earth Imagery at Work, and Going Places with 

Spatial Analysis both use ArcGIS Pro, Insights, and other tools. 

Authoring 3D Scenes: 

https://www.esri.com/arcgis-blog/products/arcgis-online/3d-gis/authoring-3d-layers-and-creating-web-

scenes-in-arcgis-online/ 

Getting Started with ArcGIS Pro: Introduces the ribbon-style interface, project-based organization, and 

key capabilities of ArcGIS Pro: 

https://www.esri.com/training/catalog/57630435851d31e02a43f007/getting-started-with-arcgis-pro/ 

Displaying Data in ArcGIS Pro: Introduces ArcGIS Pro tools for symbology.  

https://www.esri.com/training/catalog/57630433851d31e02a43ee9e/displaying-data-in-arcgis-pro/  

3D Visualization Using ArcGIS Pro: Introduces the ArcGIS Pro 3D environment and explains how to create 

and share realistic 3D scenes. 

https://www.esri.com/training/catalog/5763042d851d31e02a43ed91/3d-visualization-using-arcgis-pro/  

Managing Map Layers in ArcGIS Pro: Introduces basic layer property settings.  

https://www.esri.com/training/catalog/57630431851d31e02a43ee5e/managing-map-layers-in-arcgis-

pro/  

Querying Data Using ArcGIS Pro: Teaches the building blocks of query expression and how to select 

features that meet one or more attribute criteria. 

https://www.esri.com/training/catalog/57630433851d31e02a43eeaa/querying-data-using-arcgis-pro/  

Integrating Data in ArcGIS Pro: Teaches GIS data concepts and adding data to a geodatabase: 

https://www.esri.com/training/catalog/57630436851d31e02a43f0fd/integrating-data-in-arcgis-pro/  

Preparing to Perform Analysis Using ArcGIS Pro: Presents using ArcGIS geoprocessing tools that support 

spatial analysis projects. Discusses how to choose the appropriate tool, and works through a short 

project: 

https://www.esri.com/training/catalog/57630435851d31e02a43f022/preparing-to-perform-analysis-

using-arcgis-pro/  

Automating Workflows Using ArcGIS Pro Tasks: Teaches how to create and share ArcGIS Pro tasks to 

increase productivity: 

https://www.esri.com/training/catalog/57957ed130a990c02999b51c/automating-workflows-using-

arcgis-pro-tasks/ 

Sharing Maps and Layers with ArcGIS Pro: Teaches best practices for sharing projects, maps, layers, 

tools, and other items using a portal, such as ArcGIS Online: 

https://www.esri.com/training/catalog/57630436851d31e02a43f0eb/sharing-maps-and-layers-with-

arcgis-pro/ 

Actionable intelligence – spreadsheet and symbology: 

https://www.esri.com/training/catalog/57660973ed5a246c117f0f82/actionable-intelligence/ 
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Cartographic creations: 

https://www.esri.com/training/catalog/592480f42a01eb14e793d0e7/cartographic-creations-in-arcgis-

pro/ 

Creating and sharing animations: 

https://www.esri.com/training/catalog/58517380d33f8b0b47b78e3f/creating-and-sharing-animation-

in-arcgis-pro/ 

Creating vector tiles: 

https://www.esri.com/training/catalog/5851736fd33f8b0b47b78e26/creating-vector-tiles-in-arcgis-pro/ 

ArcGIS Pro editing essentials: 

https://www.esri.com/training/catalog/5a01f9d077179c47d977f270/arcgis-pro-editing-essentials/ 

Assess burn scars with satellite imagery: 

https://www.esri.com/training/catalog/576609bded5a246c117f0f90/assess-burn-scars-with-satellite-

imagery/ 

Distance analysis using ArcGIS Pro: 

https://www.esri.com/training/catalog/57630433851d31e02a43eee1/distance-analysis-using-arcgis-

pro/ 

Terrain analysis using ArcGIS Pro: 

https://www.esri.com/training/catalog/57630436851d31e02a43f18f/terrain-analysis-using-arcgis-pro/ 

Creating viewsheds using ArcGIS Pro: 

https://www.esri.com/training/catalog/57d8718d8b3e1ff2376bf91c/performing-viewshed-analysis-in-

arcgis-pro/ 

Creating Optimized routes using ArcGIS Pro: 

https://www.esri.com/training/catalog/57ae3ba542de278c0a03657f/creating-optimized-routes-using-

arcgis-pro/ 

Generating Service areas using ArcGIS Pro: 

https://www.esri.com/training/catalog/57bcfdd581e455607e4a59aa/generating-service-areas-using-

arcgis-pro/ 

Regression analysis using ArcGIS Pro: 

https://www.esri.com/training/catalog/57630430851d31e02a43ee0c/introduction-to-regression-

analysis-using-arcgis-pro/ 

Building geoprocessing models using ArcGIS Pro: 

https://www.esri.com/training/catalog/57630433851d31e02a43eebc/building-geoprocessing-models-

using-arcgis-pro/ 

Using the R-ArcGIS bridge:  

https://www.esri.com/training/catalog/58b5e417b89b7e000d8bfe45/using-the-r-arcgis-bridge/ 
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Analyze crime using spatial statistics and the R ArcGIS bridge:  

https://www.esri.com/training/catalog/58a20cbd2b739eb1438e9da5/analyze-crime-using-statistics-

and-the-r-arcgis-bridge/  

Scripting: 

Esri Developers:  https://developers.arcgis.com/  

Esri Developers Labs:  https://developers.arcgis.com/labs/  

Arcade scripting language:  https://developers.arcgis.com/arcade/ 

ArcPy 

http://desktop.arcgis.com/en/arcmap/10.3/analyze/arcpy/a-quick-tour-of-arcpy.htm 

Try It Live notebooks with the Python API: 

https://developers.arcgis.com/python/guide/install-and-set-up/ 

Books: 

Key publishers:  Esri Press, Packt, McGraw Hill, Macmillan 

Key authors:   Tripp Corbin, Kathryn Keranen/Bob Kolvoord, Meribeth Price, Bradley Shellito, Pinde Fu 

Key series:  The GIS Tutorial, Getting to Know ArcGIS  

15 selected books, shown below. 
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